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Introduction 

Welcome to TheBrainÊ, your ultimate digital memory and no limits mind mapping 
software. Intelligence comes from the mindôs ability to think associativelyðthat is, 
to leap from thought to thought, building webs of greater and greater complexity, 
until new ideas are built. Associations are our inspirations. TheBrain allows you to 
organize your information in the same way, without limiting you to a pre-
determined file structure. In fact, with your digital brain there are no limits. You can 
create a small project-focused brain or grow your brain to hundreds of thousands 
of thoughts! 

Now you don't have to force any idea or project into a single folder. TheBrain 
organizes information as thoughts. Unlike folder directories and search lists, a 
ñthoughtò in your brain can have many connections and contexts. Moreover, 
TheBrain displays your thoughts by concept or project, linked according to how 
you think. Now you can get the big picture and discover information that might 

otherwise be overlooked.  

Thoughts contain relevant notes, web pages, and files. Brains can be synced for 
easy access from your desktop to TheBrain Cloud or your mobile devices. 

 

Figure 1. TheBrain Interface 

Thoughts are Information 

TheBrain thoughts can represent just about any type of information, including 
concepts, people, documents, spreadsheets, images, videos, shortcuts, and web 
pages. By letting you create links and associations between thoughts, TheBrain 

expands to become a visual interface that reflects the way you think. 
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Using simple click-and-drag techniques, youôll be able to create and navigate 
through networks of thoughts in a conceptual space unique to your work habits. 
When you begin using TheBrain, you will find that your computer becomes easier 
to useðfaster, more enjoyable, and less frustratingðhelping you use your time 
more efficiently. 

TheBrainôs Dynamic Graphical Interface 

TheBrain lets you create a simple, dynamic graphical map in which to input and 
navigate all your information. Your brain starts with a single thought, to which 
several other thoughts can be visually linked. These thoughts have their own 
links to other thoughts and, possibly, to each other. TheBrainôs flexible structure 
allows any thought to be linked to any other thought, so you are never more than 
a few steps away from the information you are seeking. Itôs simple to make 
connections between thoughts so that they reflect the connections you make in 
your mind. 

Cross Platform Accessibility  

Brain data is accessible from virtually any device with rich full-featured clients on 
Windows and macOS plus mobile clients for iOS and Android. Additionally, you 
can access your brain via a web browser by logging in at www.thebrain.com. 
TheBrainôs sync service keeps all your data backed up and synchronized over 

the cloud for seamless access. 

This user guide is focused on the Windows and macOS software. Please visit 
www.thebrain.com for information about the mobile clients.  

About this Guide 

The following icons are used throughout this guide to flag categories of 
information: 

 

This icon is used to identify notes. 

 

This icon is used to flag tips and suggestions. 

TheBrain is offered in two editionsðFree and Pro. Icons are used throughout the 
guide to flag features that are specific to the Pro edition. Features that are 
available in both editions are not designated with a special icon. 

 

This icon is used to indicate that the feature is available in the Pro edition only. 

http://www.thebrain.com/
http://www.thebrain.com/
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Because TheBrain works on Windows and macOS, OS-specific features are 
flagged with icons throughout the guide. Features that are available for both 
Operating Systems are not designated with a special icon. 

 

This icon is used to indicate that the information applies only to computers 
running macOS. 

 

This icon is used to indicate that the information applies only to computers 
running Windows. 

In addition: 

Labels Names of buttons, menus, commands, keys, and icons appear in this font 
throughout the guide in order to stand out. 

Note to macOS Users 

 

Right-clicking: Most features in TheBrain can be accessed with just a single 
click of your primary mouse button. However, there are several context-
sensitive shortcuts available in context menus which appear when right-
clicking. On a Macintosh, many systems do not have a right mouse button. For 
trackpad users, click or tap with two fingers. Alternatively, hold down the 
Control key while you click. Note that many mice can be set up to interpret 
clicks on each side of the main button differently so that Control-clicking is not 
necessary. To enable this, alter the Mouse settings in the System Preferences 
area of your Mac. Select ñSecondary Buttonò for the right side of the mouse. 

Ctrl key: Some features are accessed by clicking while holding down the Ctrl 
key on Windows. For macOS, use the Command key. 

TheBrain 13 supports Native Apple Silicon. 

 

 

Here is a list of working definitions for the basic terms used throughout TheBrain.  

Brain A collection of associated thoughts, each of which can have 
content. You can create multiple brains. 

Thought The topics that you link together in your brain are called 
thoughts and are the basic unit of a brain. A thought can 
represent anything you want it to. It can include an icon, notes, 
and one or more attachments (such as files and web sites) or it 
can have no content at all and simply act as a subject heading 

or organizer. Minimally, a thought has a name. 
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Plex The visible, graphical portion of your brain that displays your 

thoughts. 

Content Area The portion of TheBrain window that displays content that can 
be associated with the active thought or link. Types of content 
include notes, attachments (such as worksheets, presentations, 
documents, videos, and images), links, URLs, and events. The 
content area also displays and provides quick access to related 
thoughts. 

 

 

Clicking any thought or link in the plex displays its associated content in the 
content area.  

 

 

Figure 2. TheBrain Plex and Content Area 

Active 
Thought 

The active thought appears in the center of the plex and is 
the current focus. Any items attached to the thought, like 
notes, files, links, and events appear in the content area.  

 

Figure 3. The Different Ways a Thought Can Appear 
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As shown below, when you click a thought, it moves to the center of the plex and 

it becomes the active thought.  

 
Figure 4. Activating a Thought 

Thought 
Relationships 

A thought is said to be a ñparent thought,ò ñchild thought,ò 
ñsibling thought,ò or ñjump thoughtò based on its relationship 
to other thoughts with which it is linked.  

In your own life, you may be someoneôs parent, and 
someoneôs child, and someoneôs sibling, and someoneôs 
peer, advisor, or colleague. So, who are you? The answer to 
that question is relativeðit depends on the circumstances 

and what hat youôre wearing at the moment.  
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Figure 5. Relationships are Relative to You 

The same applies to thoughts. The relationships between 
thoughts are displayed automatically, based on which thought 
is active at the moment.  

 

Whether a thought is a parent, child, or sibling depends on its 

current relationship to the active thought.  

 

Figure 6. Thought Relationships are Relative to the Active Thought 

Child 
Thought 

Child thoughts are subtopics of the active thought. They 
appear in the ñchild zone,ò below the active thought. In the 
picture above, the active thought ñHobbiesò has seven child 
thoughts. 
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Parent 
Thought 

Parent thoughts represent superordinate topics of the active 
thought. They appear in the parent zone, above the active 
thought. 

Sibling 
Thought 

Sibling thoughts share a parent with the active thought. They 
appear in the sibling zone, to the right of the active thought. 
In the picture above, ñFamily,ò ñFood,ò ñHealth and Fitness,ò 
ñHome Projects,ò ñMy Passion,ò ñMy Pet,ò and ñPersonal 
Financeò are siblings of ñHobbiesò because they are all 
children of ñPersonal Life.ò Sibling thoughts will not be 
displayed if there are more than 50 parents to show in the 
current plex. 

Jump 
Thought 

Jump thoughts are related to the active thought but are 
neither child nor parent topics. They appear in the jump zone 
to the left of the active thought. Jump thoughts have an 
ñequal weightò relationship with the thought to which they are 
related. For example, as shown above, ñHobbiesò has the 
various hobbies ñArt and Culture,ò ñGardening,ò ñMusic,ò 
ñSnorkeling and Diving,ò ñSports,ò ñTechnology,ò and ñWhat 
Iôm Reading Nowò linked as child thoughts since they are 
types of hobbies. ñBudgetò affects the amount of resources 
available to spend on the various hobbies and so it is closely 
related, but it is not a hobby itself. Therefore, it makes a 
perfect jump thoughtˈrelated, but not part of the main 
thought grouping. 

Gate Thoughts in the plex have three circular ñgates,ò each of 
which is used to link a specific type of relation: The parent 
gate is above a thought, the child gate is below it, and the 
jump gate is to the left or right of it. A gate is hollow when 
there are no links attached to it and solid when one or more 
links are attached. Solid gates in a contrasting color have 
links to thoughts that are not currently showing in the plex. 
The color of gates is based on the current color scheme. 
When you point at a gate, a highlighting circle appears 

around it. 

Link A link is the line that connects two thoughts. When used as a 
verb, to ñlinkò is the act of connecting thoughts to establish 
close relationships. Links can also show direction to help you 

visualize relationships. 
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Figure 7. Thought Gates 

Installing TheBrain and Creating a Brain Account 

The first time you download and install TheBrain, youôll be prompted to log in or 
create an account if you donôt already have one. The log-in window provides the 
ability to create a new account or log in to an existing account. 

 

Figure 8. TheBrain Log-in Window 

Here are the fields to complete if youôre creating a new account: 
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Figure 9. Creating a New Account 

After you click the Create Account button, TheBrain will send an email to the 
address you specified.  

 

Check for a message from no-reply@thebrain.com. Make sure to check your 
spam folder if you donôt receive the message promptly.  

When you open the message, you will see a green Activate Brain Account link. 

After you click the link, youôll see a notice confirming your success. 
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Figure 10. Activating a New Account 

Now you can return to TheBrain and log in. 

 
Figure 11. Welcome to TheBrain 
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Click ñCreate a Quick-Start Brainò and follow the directions on the screen to enter a 
personalized name for this brain. The Quick-Start brain is actually a dynamic 
resource for learning more about using your brains and youôll find a wealth of 
useful information in it. Click any of the links to see what is displayed.  

You can always create a new Quick-Start brain by selecting the Create a Quick-
Start Brain command on TheBrain Help menu. 

Opening Older Brains 

When youôre looking at old and new brain files, note that brains created in 
TheBrain 7 or 8 have filename extensions of .brain. Brains created in some earlier 
versions have a .brn filename extension.  

 

To open a .brn file that you created in a version older than TheBrain 8, first 
open it using TheBrain 8 and then import the resulting brain in TheBrain 13, as 

described in the steps below. 

 

Any older Brain must be opened in TheBrain version 8.0.2.2 before it can be 
imported into TheBrain 13. Version 8.0.2.2 can still be downloaded and 
installed. Please contact support@thebrain.com for a v8.0.2.2 download link. 

To open a brain that you created in TheBrain 8: 

1. Open TheBrain. 

2. Click the File menu, then click the Import command. 

 
All dialog boxes can also be navigated via the Tab and Arrow keys.  

 

mailto:support@thebrain.com
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Figure 12. Import Box for Opening an Older Brain 

3. Click the Select File button, navigate to the brain of your choice, then click 
the Open button when the file is selected. You will see a running progress 
report. 

4. When TheBrain has finished converting, you will see a ñConversion 
completeò message as shown below. Click the Import button.   

 

Figure 13. Import Conversion Progress 

5. When TheBrain has finished importing, you will see the following dialog 
box. Click the Open button to open the brain you just imported in a new tab 

of TheBrain window. 
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Figure 14. Open the Imported Brain in a New Tab 

Suggestions for Transitioning to Your New Brain 

Here are some tips for establishing a happy relationship with your brain: 

You may want to attend one of TheBrainôs free online seminars on getting 
startedˈTheBrain 101. To learn more about TheBrain 101, go to 

http://www.thebrain.com/101. 

Avoid ñconvertingò to a Brain-only environment all at once. Make the transition on 
a file-by-file basis so that every piece of information your brain contains will be 
useful. 

Build your brain as you goðassociating thoughts as they occur naturally. 

Avoid the temptation to move large folders into your brain. TheBrain can handle 
this, but your brain will be cluttered with thoughts you may not need. 

Remember that your first brain doesnôt need to be your only brain or your last 
brain. Experiment! Create a brain just for fun, to try out the possibilitiesðgive 
yourself room to stretch and explore. Your brain is waiting! 

 

Questions? Contact TheBrain Support Team right from within TheBrain app by 
choosing Contact Us from the Help menu in TheBrain toolbar. 

 

http://www.thebrain.com/101
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Understanding Thought Relationships 

There are no rules governing the relationships between thoughtsðwhatever 
makes sense to you is the way your brain ought to be organized. The three 
primary relationship typesˈchild, parent, and jumpˈcan be used to express 
different types of relationships. Sibling is a relationship that is derived from 
child/parent relationships.  

The examples in this section can help you understand the variety of relationships 
and how they are used. The core concepts behind each type of relationship are 
as follows: 

Á Children: Child thoughts are usually used to link more specific information or 

information that represents a sub-category. 

Á Parents: Thoughts linked as Parents are usually used to link more general 
information. Parents can also be thought of as higher-level categories to 
classify groups of information. They serve to indirectly connect their child 

thoughts as siblings. 

Á Jumps: Jump thoughts are usually used to link two pieces of information that 
are exclusively related, meaning that the two items are related to each other 
but neither represents a group that the other is a part of. 

Letôs move on to an example to explore these relationship types. Imagine that 
you are the owner of a company and you are reviewing personnel files. Each 
employee has a file. You decide it makes sense to organize your employees by 
department. Your brain is called My Brain. From My Brain, you create a child 
thought called My Company (see Figure 15). My Brain is now My Companyôs 
parent thought. You create four child thoughts from My Companyð
Manufacturing, Sales, Service, and Billing. These departments are sibling 
thoughts of each other. 
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Figure 15. Sample Brain 

Now you go to each department and create more child thoughts, one for each 
employee of the department. If an employee splits time between two 
departments, you can make him a child thought of both departmentsðheôll 
appear in both and you wonôt have to duplicate his thought. In this example, Bob 
is a child thought of both Manufacturing and Sales (see Figure 16). This is one of 
the most powerful features of TheBrainðhaving one thought under more than 
one heading. 

 

Figure 16. Child Thought with Two Parents 
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If you own more than one company, but have one accountant for all of them, you 
might want to create a thought called Accountant and link it as a jump thought to 
each company, as shown below.  

  

Figure 17. Jump Thoughts to the Active Thought 

Imagine that Joeôs company has just purchased one of your companies. Since 
Joeôs company now owns this company, Joeôs Company becomes a parent (see 
below). 

  

Figure 18. New Parent Thought 
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Because Joe wants to avoid a conflict of interest, the acquired company (My 
Other Company) no longer uses the same accountant. So its jump gate is hollow, 
while its siblingôs jump gate (My Company) maintains that link and is filled. 

As you use TheBrain, you will develop a sense of the types of relationships you 
wish to make between thoughts. It is always easy to change relationships by 
adding and removing links (see Changing Relationships Using Drag and Drop on 
page 103). 

Families of Thoughts 

It is tempting to view thought relationships as families, and indeed these different 
parts of your brain are types of families, with their ancestry visually spread before 
you, represented by subjects and categories. But unlike human families, a child 
thought can be a parent of one of its siblings and a thought can have more than 

two parents. 

The complex relationships you can form in TheBrain are the source of its power. 
Letôs consider sibling thoughts that also share a parent/child relationship. 

Letôs say you are studying philosophy. You might have a thought called 
Philosophy. Individual philosophers such as Plato and Aristotle could be child 
thoughts of Philosophy. Each of these siblings, in turn, may have child thoughts. 
Aristotle was a student of Plato, so you may want to make Aristotle not only a 
child of Philosophy, but of Plato, so that when youôre working with Aristotle, Plato 

is only a thought away. 

  

Figure 19. Example of Parent/Child Relationships 
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Notice that when Philosophy and Plato are in Aristotleôs parent zone, their 
relationship (Philosophy is a parent thought of Plato) is shown by the line linking 
the child gate of Philosophy to the parent gate of Plato.  

Clearly, TheBrain is a powerful method of organizing ideas and information. No 
hierarchical file structure can provide as much cross-referenced information at a 
glance. And our example is pretty basicða fully developed brain can hold many 
more relationships and much more information. 
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Navigating Your Brain 

All thoughts can be connectedðdirectly or indirectlyðeven thoughts that may 
seem to have nothing to do with each other can be related through a chain of 
links.  

Letôs look at an example, say, the Queen of England and asparagus. You have a 
thought called Queen of England. One of its child thoughts is Prince of Wales, 
which has a parent thoughtðFamous Princesðthat is also linked to the story of 
the Frog Prince.  

 

The story has another parent thought called Fairy Tales. A sibling of Frog Prince 
is Jack and the Beanstalk.  

 

Jack and the Beanstalk has child thoughts called Giant and Jack. Giant has 
another parent thought called Famous Giants.  

 

Famous Giants has a child thought called Jolly Green Giant. Jolly Green Giant 
has child thoughts named after canned vegetable products, one of which is 

Asparagus. Thus, the Queen of England is connected to asparagus! 

 

Depending on the relationship you create between them, thoughts may be 
closely or distantly related. Thoughts are considered to be closely related when 
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they are linked directly or are siblings. In the default view of the plex, only close 
thoughts of the active thought are always displayed in the plex. Thoughts that are 
one additional step (generation) away from the active thought can be displayed 
by expanding the view. See Advanced Navigation and Alternative Views on page 
142 for information about the different view options. 

Opening a Brain 

When you log into TheBrain 13, and no brain is open, all local, synced or online 
brains will be displayed as thumbnails in the Brains tab, as shown below. This is 
assuming that you have already created one or more brains. Clicking on a brain 
thumbnail opens that brain. Or, hold down the Ctrl key as you click to open a 
brain in a new tab, leaving the Brains tab open. 

 

Figure 20. Example of Four Available Brains on the Brains Tab 

By default, brains are listed according to how recently they have been accessed. 
You can also see the list of brains sorted alphabetically using the Brains tab 
toolbar, shown below. All brains that are locally available are shown first, 

followed by brains that are available online.  
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Figure 21. The Brains Tab Toolbar 

The status of whether each brain is available locally, online, or both is also 
displayed. Each brain in the Brains tab will have an icon appearing in the lower-
right corner of the thumbnail. Right-click on a brain or click on the status icon to 
display a menu of options for that brain, as shown below. The appearance of the 
icon(s) help you identify whether the brain is Local, Synced (local and online) or 
Cloud (Online only). 

 

Figure 22. Icons Indicating Local, Synced, or Cloud 

 

Figure 23. Status Indicator Icons 

Opening a Brain that Doesnôt Appear as a Tab 

If you have a brain from an older version or from a backup, it will not appear in 
the Brains tab until you import it. Click the File menu, then the Import command. 
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Choose the type of file you want to import, then click the Select File button, 
navigate to the file of your choice, then click the Open button when the file is 
selected. Click the Import button after TheBrain has finished converting the 
brain. 

Managing Brains Using the Tabs 

The tabbed interface of the plex lets you switch instantly between brains or even 
keep the same brain open in multiple Brain tabs or windows. 

To re-open the Brains tab to display the Brain thumbnails, click the + icon to the 

right of the last tab.  

 

Figure 24. Click the + Icon to Open the Brains Tab 

  

There is no limit to the number of brains you can open at once. Each time you 
open a brain it will appear in a separate tab. Switch from brain to brain 
instantaneously by clicking its tab. All tabs and their states are automatically 
saved and restored when you quit and restart. 

Á Float tabs into their own dedicated window by dragging a tab out of TheBrain 
application window. This creates a new Brain application window with just a 
single tab. 

Á Merge tabs into one window by dragging and dropping. Click the tab of one 
Brain window and drag the tab to another open brain, hovering over the tab 

area. Then release the mouse button. 

Á Open the same brain in multiple tabs to view and edit multiple areas at a 
time. This lets you view different areas of your brain at the same time, and, if 
you like, use a different layout in each tab. Note that tabs are simply views 
into the same brain data and changes made in one tab affect all other tabs of 
that brain. 

Á Duplicate tabs. Right-click on a brain tab to duplicate it, showing the same 
content in a new Brain tab. 
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Windows Menu 

From Windows menu in the menu bar youôll have the option to move between 
brain tabs, move tabs to new windows or select a specific brain tab to be 
activated. 

Additionally, if you have adjusted the layout of a brain with the Smart Splitter, you 
can select the option to Reset Window which will bring the plex/content area 

back to their default views. 

Managing Brains Using the Context Menu 

You can right-click any brain in the Brains tab to display the available options. 

 
Figure 25. The Context Menu in the Brains Tab 

Tip: Press Ctrl/Cmd + click to open a brain in a new tab from the brains list page.  

 

Opening Content Associated with a Thought 

As you navigate through your brain, the content associated with the active 
thought is displayed in the content area. Notes associated with the thought are 
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displayed automatically. There are several ways to open an attached file or web 

page:   

Á Click on the link for the attachment in the content area. 

Á Click on the attachment icon to the left of the thoughtôs name in the plex. 

Á Right-click on the thought, click Open Attachment on the context menu, then 

click the attachment of your choice. 

Showing Thought Content on Hover 

By default, the content for the active thought displays in the content area. If you 
prefer, you can display content for any thought your mouse pointer hovers over 
by changing the setting. To do so, click the Options menu (TheBrain menu on 
macOS), click Preferences, click the Behavior tab, then select the ñUpdate 
displayed content on mouse hover or keyboard highlightò check box. Close the 

Preferences window when youôre finished. 

Previewing Thought Content  

Certain types of file attachments are automatically previewed inside of TheBrain. 
These include web pages, images, text, markdown files, JSON, .html files and 
PDFs. Simply click on an attachmentôs tab and its preview will be shown. In the 
example below, Tropical Getaways is the active thought and there are two 
attachments in the content areaðan image and a PDF.  

  

You can view multi-page PDFs, web pages, and images as a slide show within 

the content area. 

 

Á Click the link for an attachment to open a preview of it in the content area. 

Á Click the Next or Previous arrow in the top-right corner of the attachment to 
move back and forth between attachments (or back to the notes in the 

content area). 

Á Click the Close button (X) to end the preview and return to the notes. 

Á Click the Open button to open the file outside of TheBrain. 
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Figure 26. Content Area for the Active Thought 

The PDF preview features: 

Á Supported rendering for each OS 

Á Support for very large, multi-page PDFs 

Á Thumbnails of each page, zoom, rotation, search, and printing 

Á All PDF commands can be mapped to a custom keyboard shortcut 

Editing Additional Notes 

Adding additional attachments to a thought, such as .md and .txt files will enable 
you to also edit these attachments the same as you would a brain note.  

Pins 

Pins are shortcuts to thoughts to which you want quick access. They appear at 
the top of the plex, just below TheBrain toolbar. No matter where you are in your 
brain, the pins remain visible. 
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Figure 27. Pins 

To create a pin: 

Á Use the Toggle Pin button in the main toolbar to create a pin for the Active 
Thought or right-click the thought for which you want to create a pin, then 
click Create Pin on the context menu  

 

 
Figure 28. Toggle Pin Button 

 

To remove a pin: 

Á Use the Toggle Pin button in the main toolbar to remove the pin for the 
Active Thought or right-click the pin or on a thought that has a pin, then click 

Remove Pin on the context menu 

 

Removing a pin does not remove or delete the associated thought; it deletes 
only the reference to it at the top of the plex. 
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To use a pin to link thoughts: 

Á Drag from one of the thought gates to the pin, or 

Á Move your mouse pointer over a pinned thought and gates will appear; drag 
from one of these gates to the thought you want to link 

Activating Recent Thoughts: The Past Thought List 

TheBrain keeps a running breadcrumb trail of your thoughts based on activation 
and displays it in the Past Thought List. You can think of the Past Thought List as 
the visual representation of the phrase, ñtrain of thoughtòða scrollable list of 
thoughts in the order you activated them. The Past Thought List is displayed at 
the bottom of the plex window. 

Clicking on any thought in the Past Thought List activates that thought. Also, 
when a new thought is created it appears in the Past Thought List immediately.  

 

Figure 29. Past Thought List 

The left and right arrows to the left of the Past Thought List enable scrolling to 
see items that donôt fit on the display.  

The most recently activated thought (the currently active thought) appears at the 
right end of the list. 

To use a thought in the Past Thought List to link thoughts: 

Á Drag from one of the thought gates to one of the thoughts in the Past 

Thought List, or 

Á Move your mouse pointer over a thought in the Past Thought List and gates 
will appear; drag from one of these gates to the thought you want to link 
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In the example below, Tropical Vacations is going to become a parent of Airline 
Rewards; the mouse is being dragged from the child gate of Tropical Vacations 
to Airline Rewards in the Past Thought List. 

 

Figure 30. Creating a Link using the Past Thought List 

Using the Back and Forward Buttons: 

Á In addition to the Past Thought List, you can also use the Back and Forward 
buttons, located near the top of the Window, to quickly retrace your steps; 

these buttons work just like they do in a web browser 

 

Á Click the Back button to go back to the last active thought 

Á Once you have clicked the Back button, the Forward button can be used to 
re-activate the thought you came from 
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Back and Forward Mouse Buttons: The back and forward buttons available on 
some mice (typically on the left side of the mouse near where you place your thumb) 
may be used to navigate backward and forward in your brain. These mouse buttons 
perform the same navigation as the Back and Forward buttons in the Brain toolbar, 
shown above. 

Searching a Brain 

Instant Activation 

TheBrain includes powerful search capabilities. The Search box is in the top-right 
area of the application. 

 
Figure 31. The Search Box 

The term ñinstant activationò refers to TheBrainôs ability to quickly find whatever 
youôre searching for and activate the related thought. You can easily scan the 
search results as you type in the Search box. There's no need to click in the 
Search box, your cursor is always there by default, unless you are actively typing 

in the content area or another field. 

A content area preview will automatically appear for each choice you highlight. 

To activate one of these results, click it with your mouse or use the up-arrow, 
down-arrow, page up, and page down keys on the keyboard then press the 

Enter key.  
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Figure 32. Instant Activate Finds Matches Based on Thought 
Names, Labels, Notes, and Attachments 

 

Accents are ignored when matching thought names. Also, when two or more 
matches with the same name are found, the names of their parent or jump 
thoughts are also displayed so you can differentiate them. 

You can search for thoughts by typing the first letter(s) of separate words and the 
letters can be in any sequence; for example, to find the ñFamily and Friendsò 
thought you could type ñfa fr,ò or ñfr fa,ò or ñfa and fri.ò 

 

Figure 33. Use First Letters of Separate Words for Instant Activate 
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Attachments and note search matches are identified with a yellow piece of paper 

icon for notes and a paper clip icon for Attachments. 

 
Figure 34. Search Results 

When you do a search, the results are sorted with results that match thought 
names first, then notes, then attachments. Within the thought name matches, 
they are ranked in groups: 

Á Exact Matchesðwhere the entire name of the thought matches the entire 
query 

Á Starting Matchesðwhere the entire query occurs at the start of the thought 
name 

Á Continuous Matchesðwhere the entire query occurs anywhere in the 
thought name 

Á Matchesðwhere every term in the query occurs somewhere in the thought 
name 

Within each group, thoughts that have been activated in the last 30 days will be 
shown first, ordered with the most recently activated first. Thoughts that have not 
been activated within 30 days are sorted alphabetically. 

 

Searching within Attachments 

 Your searches automatically include matches based on the contents of 
attachments. If the text youôre searching for exists within documents including 
PDFs, Word, Excel, PowerPoint and many other file formats, the documents 
containing the text will be found. 
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On Windows, TheBrain utilizes Windows Search to provide search results to 

Brain notes and file attachments.  

 

TheBrain integrates with Spotlight on macOS to provide search results from 
within file attachments. No setup or additional steps are required to enable this 
functionality. 

 

 

For searches in TheBrain to return accurate results, Windows Search or 
Spotlight will need to have access to the location where your brains are being 

stored.  

Using the Search Box to Search the Web 

Say youôre searching for something and come up with no hits. For example, 
youôre on a neighborhood committee and youôve volunteered to look into an issue 
with squirrels. You type ñsquirrelsò in the Search box. No results? Press the F4 
key to search the web. 

 

Figure 35. Search-Engine Choices 

Á Click the drop-down arrow if you want to select a different search engine, 
then click the Search button to begin searching the web based on what 
youôve typed. 

Á When you find a site you like, you can add it to any thought in the usual way. 
The Web Search box will close automatically after you click the Search 
button. 
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To modify, add, or reset search-engines: 

Á Click the Edit button in the Web Search box. 

 
Figure 36. Editing Search-Engine URLs 

To customize the search-engine choices: 

Á Click and edit any URL string to customize it, or 

Á Click the Add New button to enter a name that isnôt already in the list, or 

Á Click the Reset button to return to TheBrainôs default choices 

Click the OK button to save your customizations or click the Cancel button to 
close the box without making changes. The original Web Search box will still be 
open, still showing the text you were searching for. 

Additional Search Functionality 

Search has several additional capabilities that are automatically enabled. 

Á You can find and execute commands from the Search box. To begin, type a 
forward slash (/) in the Search box. An alphabetical list will appear. The list 
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will be fine-tuned to match what you type. This option can also be accessed 

from the Search Commands and Preferences option under the Help menu. 

 

Figure 37. Executing a Command from the Search Box 

Á External attachments are included in search results 

Á Search using acronyms (ex. find "New York Stock Exchange" by typing 
"nyse") 

Á Search for thoughts starting with punctuation. You may use this as a shortcut 
to provide fast access to thoughts that you always start with a certain type of 
punctuation. For example, you could use this for people (@Mike, @Sally, 
@Debbie, etc.) or projects (#Ridgeline, #Palmdale, #Westly, etc.) 

 

Figure 38. Search Results for Both Internal and External Attachments 

Á Below the search box is an option for searching Childward only. Selecting this 
option will limit the search results to 3 generations below the current active 

thought. 



 Customizing Your Brainôs Environment 

TheBrain 13 User Guide 35 

Customizing Your Brainôs Environment 

You may choose to use your brain just as itôs offered ñout of the boxò or you may 
choose to change some of the environmental settings to suit your personal 
preferences. 

TheBrainôs Default Settings 

Without making any changes, hereôs what your brain looks like: 

Á The area where your thoughts appear (the plex) will be the color and design 
of one of TheBrainôs ñThemes.ò The initial theme is randomly selected and 
you can change it at any time. 

Á The left half of TheBrain window will display your thoughts and the right half 
of the window will display the ñContent Areaò which holds notes and any other 
items you will attach to your thoughtsðfiles, web pages, Events, etc. 

Á Your thoughts will be displayed in ñNormalò view, meaning that you will see 

only the direct parents, children, jumps, and siblings of the active thought. 

 

Figure 39. TheBrain Window with Default Settings 

Using Smart-Splitter to Arrange TheBrain Window 

The smart-splitter controls let you manage where the plex and content area 
display relative to each other in the Brain window.  
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Figure 40. Smart-Splitter 

Á Click the individual left- and right-arrows (or up- and down-arrows if the 
window is in ñover-and-underò mode) to maximize the area the arrow is 
pointing towards (either the plex or the content area). 

Á Click the double-headed arrow icon to toggle the plex to the right or left side 
of the content area. 

Á Click on the two-arrow icon that forms a box to toggle between seeing the 
plex and content area "side-by-side" or ñover-and-under.ò 

Á You can also point at the border between areas and click and drag when the 
double-headed arrow appears to move the border. 

Moving Thoughts in the Plex 

When the default settings are in use and the plex is in ñNormalò view, you can 
move the thoughts in the plex up or down, vertically, by dragging (up or down) in 
any blank area of the plex background. 
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Figure 41. Dragging the Plex Vertically 

Resizing Thoughts in the Plex 

The plex is the heart and soul of TheBrain. You can change the size of thoughts 
in the plex by using TheBrain toolbar or your keyboard and mouse. 

To change the size of thoughts using the toolbar: 

Á Click the AA button to activate the slider, then click and slide the bar up or 
down to grow or shrink the size of your thoughts. 
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 Figure 42. Resizing Thought Size with the Slider 

To change the size of thoughts using the keyboard, mouse, or trackpad: 

Á Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and scroll up or down 
on your mouse wheel or trackpad while your mouse pointer is in the plex. 

 

Figure 43. Resizing with the Mouse or Trackpad 

Á Hold Cmd (macOS)/Ctrl (Windows) on your keyboard and press - to make 
thoughts smaller or + to make thoughts larger. 

 

Figure 44. Resizing with the Keyboard 
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Á Pinch to zoom on a macOS Trackpad. 

 
Figure 45. Resizing on a Trackpad 

Customizing a Brainôs Appearance 

Selecting a Theme 

The Themes feature lets you choose from many built-in designs to customize the 
look of your brain, including the appearance of the plex and notes in the content 
area. You can change many of the default colors and the style of notes 
associated with the Theme, then save the look of your brain as a new Theme. 
This lets you quickly switch from one saved Theme to another. 

 

Figure 46. Sample Themes 
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To select a Theme: 

1. Either click the Options menu in TheBrain toolbar (TheBrain menu on 
macOS) or right-click any blank space in the plex. 

2. Click the Brain Theme command. 

 

Figure 47. Accessing the Brain Theme Dialog Box 

In the Brain Theme box, youôll see a scrollable list of available themes in the left 
panel and Colors and Options tabs in the right panel. Click on any Theme to 
see how it looks in the plex. 
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Figure 48. The Brain Theme Dialog Box 

Customizing a Themeôs Colors 

 

Have the Brain Theme box open when you want to customize a Theme (right-
click a blank area of the plex, then click the Brain Theme command). 

The default colors for virtually all items in the plex vary based on the selected 
Theme. The current color for each item is shown in the circle to the right of the 
itemôs description. Scroll through the list in the Colors tab to get an idea of all of 
the items that can be changed.  

To change the colors in the selected Theme: 

1. Click the item whose color you want to change to display your choices. 

2. Click the color of your choice, click outside of the box of colors to close it, 
then click Close (X) (or press Esc) to close the Brain Theme box. 
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Figure 49. New Selected Color for Links 

 

Note that while you can change the color of the shadow for thought text using 
the themeôs Color tab settings, you can toggle whether or not text shadows 
are displayed using the Look & Feel tab of the Preferences window (as 
explained in the Look & Feel Preferences section on page 59). By default, text 
shadows are displayed. 

When you are happy with your color selections, click the Close button (X) in 
the Brain Theme box. 

Defining and Selecting Additional Colors 

You can add customized colors if you donôt see the exact shade you want. 

1. In the color selection box, click the color thatôs closest to what you want, 
then click the box next to ñCustom,ò then click the Define Custom Colors 
button. 
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Figure 50. Define a Custom Color 

2. The Color window will expand to provide a slider to fine-tune the shade. 
You can also select a different color and fine-tune it or type in specific RGB 
or HSL numbers. Click the Add to Custom Colors button when youôre 
happy with the sample color, then click the OK button. 

 

Figure 51. Adding a Custom Color 

Selecting a Custom Image for the Plex 

If you want to use an image of your own instead of using one in the Themes list 
of the Brain Theme box, itôs very easy to do so. 
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To select your own background image: 

1. Click the Options tab in the Brain Theme box, then click the Wallpaper 
check box. 

 

Figure 52. Options Tab in the Brain Theme Dialog Box 

2. In the Select image file as the wallpaper window, navigate to the location 
of your image file, click on it, and then click the Open button. Supported 
wallpaper file formats include .jpg, .gif, and .png. 

3. Click the Close button (X) in the Brain Theme box to save your new image 
for the plex. 

To replace, remove, or copy a wallpaper image: 

Á To replace the image, click the Select button next to the Wallpaper check 
box to navigate to a different image. 

Á To remove the image, click the Wallpaper check box to toggle off the check 

mark and remove the image from the plex. 

Á To copy a wallpaper image to your clipboard, click the Copy Wallpaper 
button 
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Figure 53. Replacing or Removing Wallpaper 

To dynamically select new Wallpaper from a web site: 

1. Go to a web site that offers Wallpaper files, right-click the design of your 
choice, then select Copy on the context menu. 

2. Return to your brain, right-click in any blank area of the plex, then select 
Paste Wallpaper on the context menu. 

 

Figure 54. Context Menu on the Plex  

Changing the Default Font in the Plex 

By default, the font for text that appears in the plex is Helvetica. You can change 

it to any font installed on your machine: 

1. Click the Options tab in the Brain Theme box, then click the drop-down 
button for Font. 
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Figure 55. Changing the Font for Plex Text 

2. Click the font of your choice. You will see the text in the plex update 

automatically. 

Changing the Content Areaôs Default Attributes 

You can select custom colors for your notesô text, links, page, edge, and 
background. You can also change the font, size, weight (boldness), and other 
attributes for the heading and body text you include in the content areaðeither 
before or after you add it. Prebuilt Styles are also available, which you can use 
as-is, or modify. Youôll see instant previews of the changes you make, before you 
apply them. And, of course, you can change your changes anytime. 

By default, the notes in the content area of your brains appear in a style called 

ñModern,ò which is a sleek and clear combination of font, color, and size.  

To begin selecting different style attributes for notes: 

Á Click the Edit Notes Style button on the Options tab in the Brain Theme 
box, or 

Á Click the Notes Style button in the content area toolbar 
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Figure 56. Changing the Style of Notes 

 

You can also access the Edit Notes Style dialog box from the content area 
toolbar. See Choosing a Notes Style beginning on page 163. 

To change the appearance of headings: 

1. Click on an example heading for the level you want to change. For 
example, click on ñTitle Example Textò to change the top-level heading. 

2. Select an attribute from the context menu. Selecting Font, Weight, Color, 
or Letter Spacing will take you to an additional set of choices. 
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Figure 57. Style Options for Content Area Text 

 

Figure 58. Before and After Changing a Heading Color Style 
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To select a heading color that isnôt in the palette: 

Á Click Custom at the bottom of the color palette, click Define Custom Colors, 
select a color you like, then click the OK button.  

 

Figure 59. Options for Fine-Tuning Heading Text Color 

To change the size of headings: 

Á Click Small, Medium, or Large in the Heading Sizes list. The sizes will 
adjust automatically, based on the level of each heading. 

 
Figure 60. Options for Changing Heading Size 
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To change the color of non-heading text and other Content Area parts: 

1. Click the round color sample in the left panel for the element you want to 
change. 

2. When the palette opens, click the new color of your choice, or click Custom 
to select a different color. The example text will immediately reflect your 
choice. The palette stays open so that you can see what different colors 
look like when applied.   

3. Click outside the palette to close it, when youôre ready. 

 

Figure 61. Selecting a New Color for Body Text in the Content Area 

To change the font or weight of non-heading text: 

1. Click within any non-heading body text, then choose either Font or Weight 

in the context menu. 

2. To change the font, select a choice in the scrollable list that appearsðyouôll 
find over 1,000 options. Each has a sample of how it will appear.  

3. Press Esc or click outside of the list to close the box if you donôt want to 

make a selection. 
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Figure 62. Changing the Font of Content Area Body Text 

4. To change the weight (the width/boldness of the characters), select a 

choice from the list that appears. 

 

Figure 63. Changing the Weight of Content Area Body Text 

Viewing and Selecting Prebuilt Styles 

A handy way of seeing combinations of options for the content area is to visit the 
Prebuilt Stylesðif you see one you like, apply it to your brain and see the results 
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instantly. The list of Prebuilt Styles is grouped into Light, Dark, and Fun 

sections. 

As you click each Prebuilt Style, youôll see the Example Text instantly reflect the 
look. 

 

Figure 64. Selecting a Prebuilt Style 

Copying, Pasting, Importing, and Exporting Styles 

You can copy, paste, import, and export styles, making it easier to create new 
styles. Click the Actions button to display the Copy, Paste, Import, and Export 
options for Styles. 

 
Figure 65. Selecting a Prebuilt Style 
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Á Copy Notes StyleðClick when you want to apply the current notes 

formatting in another brain. 

Á Paste Notes Style (available if a note style has been copied)ðClick after 
youôve opened the brain to receive the style. 

Á Paste Colors Only (available if a note style has been copied)ðClick after 

youôve opened the brain to receive the color choices in the copied style. 

Á Export Notes StyleðClick Save after navigating to a location of your choice 
for saving the style file. The filename will look like this: Style-2021-08-
13.nstyle (except with the actual date you exported the file). 

Á Import Notes Style (available if a note style has been exported)ðwith the 
receiving brain open, choose this option, navigate to the location of the 
.nstyle file, click Open when the file is selected, then click the Apply button. 

Saving Changes 

When you are happy with your content area choices, click the Apply button, then 

close the Brain Theme box to return to your brain. 

Reverting to the Themeôs Default Settings 

 

As soon as you make any changes to a Theme, ñCustom Settingsò will be 
selected in the Themes list. 

To switch back to the original settings for any Theme, select the Theme name in 
the Themes list within the Brain Theme dialog box. 

Saving Themes 

1. Make sure the tab with the brain that has the Theme you want to save is 

active in the plex. 

2. Unless the Brain Theme box is already open, either click the Brain Theme 
command on the Options menu or right-click a blank area of the plex, then 
click the Brain Theme command. 

3. Click the Save Theme button, click Save as New (so you donôt overwrite 
the original Theme), then type a name for your new theme in the field. 
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Figure 66. Save a Theme 

4. Click the OK button. Your new Theme will be inserted into the list of 
Themes, ready for use in your other brains. 

 

Figure 67. Newly Saved Theme in the Themes List 

 

Your saved Theme will also include customizations you have made in the Edit 
Notes Styles window. 



 Customizing Your Brainôs Environment 

TheBrain 13 User Guide 55 

 

Renaming a Theme 

1. In the Brain Theme box, click the Theme you want to rename, then click 
the Rename button. 

2. Type or revise the current name, then click the OK button (or press the 
Enter key). 

 

Figure 68. Renaming a Theme 

3. Click the Close button (X) to close the Brain Theme box. 

Deleting a Theme 

1. In the Brain Theme box, click the Theme you want to delete, then click the 

Delete button. 

 

Clicking on a Theme that you want to rename will activate this Theme in your 
brain. You may want to save your current Theme first (if it has been 
customized) before renaming another, existing Theme. 
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Figure 69. Deleting a Theme 

2. Click the Delete button to confirm that youôre sure you want to delete the 
Theme. 

3. Click the Close button (X) to close the Brain Theme box. 

Importing and Exporting Themes 

 

Figure 70. Importing or Exporting a Theme 
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To import a Theme: 

Á Click the Import button, navigate to the location of the .BrainTheme file you 
want to import, select it, then click the Open button. 

To export a Theme: 

Á Make sure the Theme you want to export is in the active brain tab. 

Á Click the Export button, navigate to the location where you want to save the 
Theme, then click the Save button. 

Á Click OK in the confirmation box.  

Dark Mode 

The Dark Mode changes the windows, menus, icons and other user interface 
elements to be predominantly dark grey. Dark Mode allows you to focus on your 
work with subtle colors and fewer distractions.  

¶ To switch to Dark Mode, click the Options menu, then click the 
Preferences command (on macOS, the Preferences command is 
located in the TheBrain menu). On the Look and Feel tab, select Dark 
under the User Interface setting. 

¶ After you give permission, TheBrain will restart and apply the change. 

 

Figure 71. TheBrain in Dark Mode 

Á You may want to modify your Brain Theme to complement the darker 
interface and tones. 

Á On macOS, the Dark Mode setting will follow your OS automatically. 
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Setting Other Preferences 

TheBrainôs Preferences dialog box is where youôll find many of the settings for 
adjusting how your brain works, both mechanically and visually. Preference 
settings affect how TheBrain works globallyˈno matter which brain is open when 

you make your choices. 

To open the Preferences dialog box: 

Á Click the Options menu, then click the Preferences command (on macOS, 
the Preferences command is located in the TheBrain menu) 

 
Figure 72. Accessing Preferences 

TheBrain Preferences are organized into these categories: 

Á Look & Feel 

Á Behavior 

Á Notes Editor 

Á System 

Á Keyboard 

Á Experimental 
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Look & Feel Preferences 

 

Figure 73. Look & Feel Preferences 

User Interface 

Preference Description 

Compact Window Title Bar Moves the File, Edit, Thought, View, etc. 
menu items up into the frame of the app. 

Theme Switch between Light and Dark Mode. 

Plex 

Preference Description 

Default Layout: Select from Normal, Outline, Mind Map or 
Normal +1,  

Animation Speed Drag the slider right to reduce or left to 
increase the speed with which a thought 
becomes active when you click it in the plex. 
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Preference Description 

Wander Delay Wandering is an option to step randomly 
through TheBrain, to let you see thought 
associations. Drag the slider to specify the 
amount of delay (in seconds) between 
thought activations. The delay is shortest by 
default. 

Thoughts 

Preference Description 

Column Width Controls the minimum size that will be used 
for columns of thoughts relative to the current 
text size. 

Spacing Drag the slider to decrease or increase 
space between thoughts. The wider the 
spacing, the larger and more spaced out the 
thoughts will be. 

Tags text You can choose not to show, only show Tag 
text on hover (mouseover), or always show. 

Tags icons You can choose to never show, only show 
Tag icons on hover (mouseover), or always 
show. 

Show events indicators Event icons will appear in the bottom-right 
area of thoughts that include events. This 
preference is off by default. 

Show notes indicators Note icons will appear in the bottom-right 
area of thoughts that include notes. When 
this is selected, you can hover over the icons 
for an instant view of the corresponding note. 
This preference is off by default. 

Show siblings in normal 
view 

This preference is on by default. 

Context sensitive thought 
names 

Context sensitive thought names are 
explained on page 81. This preference is on 
by default. 

Show label for active 
thought 

This preference is off by default. 

Text shadows This preference is on by default. 

Use ClearType to render 
text (slower) 

Applies a crisper display of thought names, 
but may require more system resources. 
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Links 

Preference Description 

Curved Links When selected, links will be curved lines and 
when not selected, links will be straight lines. 

This preference is on by default. 

Timeline 

Preference Description 

Always show thought or 
link name on events 

This preference is on by default. 

Calendar week starts on 
Monday 

When checked, Monday will be the first day 
of the week. Unchecked, Sunday will be the 
first day. 

Behavior Preferences  

 
Figure 74. Behavior Preferences 
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Thoughts 

Preference Description 

On click active thought By default, the thoughtôs properties will 
display when the active thought is clicked. 

The other option is to do nothing. 

Custom thought Context 
Menu 

Click on Toggle Commands and uncheck 
options that you would like to have hidden. 

Automatically capitalize 
thoughts on creation 

The first letter of the name of the thought will 
be automatically capitalized. This preference 
is on by default. 

Activate last created 
thought 

A thought will become the active thought as 
soon as itôs created. This preference is off by 
default. 

Download Icons for 
Attached Email Addresses 
from Gravatar 

This preference is on by default. 

Content 

Preference Description 

On drag and drop of files By default, files will be copied when dragged 
and dropped. The other options are that they 
will be either moved or linked. 

Update displayed content 
on hover 

This preference is off by default. 

Show details when 
selecting attachment to 
open 

This preference is off by default. 

Show first attachment when 

notes is empty 
Preference is on by default. 

Show attachments as a list Attachments will show in the same area 
instead of on separate tabs within the content 

area. This preference is off by default. 

Show attachment 
modification date and time 

in list 

Will display the file modification date/time 
when files are viewed as a list 

Content Previews 

Preference Description 

On click attachment Select between óPreview when possibleô or 
óAlways open in default applicationô. 
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Preference Description 

Show content previews 
when searching 

This preference is on by default. 

Automatically start 
playback of media 
attachments 

This preference is on by default. 

Show page thumbnails in 
PDF preview 

This preference is on by default. 

Embedded browser for web 

links 

Linked web pages will open in TheBrainôs 

built in browser. 

Preview attachments 
immediately upon being 

attached 

Attachments being dragged and dropped into 
TheBrain will launch in the content area 

immediately when checked. 

 

Other 

Preference Description 

Sync brains on application 
exit 

Closing TheBrain application will sync all 
brains. To exit immediately when this feature 

is on, simply close the sync status window. 

Maximize on double-click 
of plex background or 

content tab background 

Double-clicking either the plex or content area 
background will maximize that part of the 
brain and the other part will be hidden. This 
preference is off by default. 

Hide brain name in tabs Removes the brain name from appearing in 

the tabbed interface. 

Treat touches like mouse 
input 

The way the plex interprets touch events can 
be altered using the preference. More 
information on this setting is available at 
https://www.thebrain.com/docs/touches-info 

Show accounts on brains 

list 

Display all available accounts below brain 

thumbnails on the brains list tab. 

https://www.thebrain.com/docs/touches-info
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Notes Editor Preferences 

 

Figure 75. Notes Editor Preferences 

General 

Preference Description 

Layout Simple (all notes on one long scrolling page) 
or Multi-Column (notes in thinner columns, 
multiple columns will be displayed where 
space is available) 

Line Spacing Set notes line spacing. 

Thought Icon Choose between Hide, Above, Below, and 

Inline½t he default icon placement is inline. 

Emoji Size Set emoji size to Small, Medium, or Large. 

Attachment Text Size Set attachment text size to Small, Medium, or 
Large. 

Custom Date/Time Format Use the default date/time layout or customize 
your own.  
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Custom date/time format for notes 

Use the following format options to customize the appearance of your date/time 
stamp in notes: 

Characters Result 

d  The day of the month, from 1 through 31. 

dd  The day of the month, from 01 through 31. 

ddd  The abbreviated name of the day of the week. 

dddd  The full name of the day of the week. 

h  The hour, using a 12-hour clock from 1 to 12. 

hh  The hour, using a 12-hour clock from 01 to 12. 

H  The hour, using a 24-hour clock from 0 to 23. 

HH  The hour, using a 24-hour clock from 00 to 23. 

K  Time zone information. 

mm  The minute, from 00 through 59. 

M  The month, from 1 through 12. 

MM  The month, from 01 through 12. 

MMM  The abbreviated name of the month. 

MMMM The full name of the month. 

ss  The second, from 00 through 59. 

t  The first character of the AM/PM designator. 

tt  The AM/PM designator. 

yy  The year, from 00 to 99. 

yyyy  The year as a four-digit number. 

z  Hours offset from UTC, with no leading zeros. 

zz  Hours offset from UTC, with a leading zero for a single-digit value. 

zzz  Hours and minutes offset from UTC. 

:  The time separator. 

/  The date separator. 
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Animation 

Preference Description 

Animate Cursor Cursor will visibly animate when clicking to 
different locations in notes. 

Blink Cursor Cursor in notes will blink to indicate its 
location. 

Highlight lines on hover Hover over any line in the notes and it will be 
highlighted. 

 

Header and Footer 

Preference Description 

Include Title This preference is on by default. Option to 
display the Thought Label in the content area 
when checked. 

Mapped Links This preference is on by default. 

Backlinks This preference is on by default. 

Unlinked Mentions This preference is on by default. 

Hide Private 
Backlinks/Unlinked 
Mentions 

This preference is on by default. 

 
Options 

Preference Description 

Select adjacent text when 

inserting link 

This preference is on by default. 

Automatic smart quotes This preference is on by default. 

Rename thought updates 
links 

This preference is on by default. 

Check spelling as you type This preference is on by default. Applies to 
spell checking while creating thought names 
as well. 

Recognize emails and 
phone numbers 

Properly formatted emails and phone 
numbers will be hyperlinked. 

Insert link when extracting 
child thoughts  

When selecting text in a note to become a 
new thought, a link to the new thought 
remains on the original note. 
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Display 

Preference Description 

Underline normal links Hyperlinked text will be underlined. 

Render underscore tags as 
italics 

Unchecked ï text within underscores will be 
underlined. Checked ï text within 
underscores will be italicized. 

Show markdown When checked, markdown tags will be visible 
in the notes. 

 

User Interface 

Preference Description 

Use compact toolbars for 

notes 

Some content area buttons will be grouped 

into dropdown lists½all tools will be available 

via the More Notes Editor Actions button. 

Show link target in pop-up When checked, hovering over a hyperlink in 
a note will display the linked URL. 

Restore cursor and scroll 

position 
This preference is on by default. 

Mentioned Thought names Select between Show all, Show except 
common words and Never show 

Clicking links in notes Follows link or Moves cursor (places cursor 
in the text) 

 
Printing 

Preference Description 

Include title Includes title when printing the note. 

Include label Include any thought label when printing 

Include links and mentions This preference is off by default. 

Include attachments This preference is off by default. 

Prevent widows and 
orphans 

This preference is on by default. 

Prevent orphan headers This preference is on by default. 

Clipboard 

Preference Description 

Replace pasted URL with 
page title 

This preference is on by default. 
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Preference Description 

Paste without formatting as 
default 

This preference is off by default. 

Exclude color information 
when pasting 

This preference is on by default. 

 

System Preferences 

 

Figure 76. System Preferences 

Updates 

Preference Description 

Check for updates on 
startup 

Notification of updates on startup. Always, 
Only free updates or Never. 

Update Channel This preference affects which kind of updates 
youôll see as available when you click the 
Check for Update command on TheBrainôs 
Help menu. The default is Stable and the 
other choices are Beta and Alpha. 

Localization 

Preference Description 

Interface Language The default is Automatic. 
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Preference Description 

Spelling Dictionary The default is Automatic and there are many 
other languages to choose from in the drop-
down list. After you select another language, 
youôll be prompted to exit TheBrain and 
restart so that your change can take effect. 

Storage 

Preference Description 

Storage The location of your brain data. The default is 
to use the default working directory for Import 

and Sync. 

Proxy Settings 

Preference Description 

Use proxy server and proxy 
server requires 
authentication 

If you are unable to synchronize your brain 
with TheBrain Cloud due to a proxy server or 
restricted ports on your network, the Proxy 
settings can be used to customize the 
synchronization process. Check with your 
network administrator for the appropriate 
information for these fields. By default, the 

Use proxy server preference is off. 

Keyboard Preferences 

Most Brain commands can be accessed by keyboard commands, which you can 
customize based on your preferences. You can even export your settings to 

share them with others or to transfer them from one computer to another. 
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Figure 77. Keyboard Preferences 

Using the Keyboard Preferences Tab 

To do this é Do this é 

Find a command quickly Begin typing the command in the Search 
commands field in the bottom-left corner of the 

Keyboard tab of the Preferences window. 

 
As you type, the list will shorten to match what 
youôve typed. When you see the command 
youôre looking for, note its shortcut or click it to 
define a new shortcut. 
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To do this é Do this é 

Collapse the list to see 
only major headings 

Click the Collapse All button. 

 
You can also collapse an individual heading, 
for example ñApplication,ò to collapse or 
expand just that section. 

Restore the full list Click the Expand All button. 

 

To do this é Do this é 

Import shortcuts Click the Actions menu button in the bottom-
right corner of the Keyboard tab, then click 

the Import Shortcuts command.  
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To do this é Do this é 

Export shortcuts Click the Actions menu button in the bottom-
right corner of the Keyboard tab, click the 
Export Shortcuts command, select a 
location for the file, then click the OK button. 
The file will be named 
ñKeyboardShortcuts.txt.ò 

Restore default shortcuts Click the Actions menu button in the bottom-
right corner of the Keyboard tab, then click 
the Restore Defaults command.  

 

To define a new shortcut: 

1. In the left column, expand a category of interest. 

2. Click the command for which you want to create a shortcut. The row 
containing the command will be highlighted and an instruction will appear 

under the Preferences tabs. 
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Figure 78. Creating a New Shortcut 

3. With the command of your choice highlighted, press the function key or 
keyboard combination of your choice. For example, you might choose to 
assign the ñCheck for Updateò command to Ctrl+Shift+U. 

 

You canôt assign keys that are already used for common operations (such as 
Ctrl-C) nor can you use letter or number keys by themselves. The Alt key can 
be used as a standalone modifier 

Your new shortcut will display in the list. You can delete the shortcut by pressing 
the Delete key while the command is highlighted. 

 

Figure 79. The New Shortcut in the List 

If the keyboard shortcut you selected is already in use for another action, you will 
have the option to ñstealò the shortcut for the current selection, or cancel the 
request and select a different keyboard combination. 
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Figure 80. Replacing an Existing Shortcut 

 
Default Shortcuts for Windows 

Application Commands Shortcut 

Exit Alt+F4 

Preferences Ctrl+, 

 

Edit Commands Shortcut 

Copy Ctrl+C 

Copy as Text Shift+Ctrl+C 

Cut Ctrl+X 

Paste Ctrl+V 

Paste without Formatting Shift+Ctrl+V 

Redo Ctrl+Y 

Select All Ctrl+A 

Undo Ctrl+Z 

 

Navigation Commands Shortcut 

Activate Tag Ctrl+G 

Activate Type Ctrl+E 

Backward Alt+Left 

Expand/Collapse Current Thought Space 

Forward Alt+Right 

Navigate Down Down 

Navigate Enter Enter 

Navigate Escape Esc 

Navigate Left Left 

Navigate Right Right 

Navigate to Pin 1 Ctrl+1 
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Navigation Commands Shortcut 

Navigate to Pin 2 Ctrl+2 

Navigate to Pin 3 Ctrl+3 

Navigate to Pin 4 Ctrl+4 

Navigate to Pin 5 Ctrl+5 

Navigate to Pin 6 Ctrl+6 

Navigate to Pin 7 Ctrl+7 

Navigate to Pin 8 Ctrl+8 

Navigate Up Up 

 

Notes Commands Shortcut 

Bold Ctrl+B 

Collapse All Ctrl+[ 

Collapse All Except Here Shift + Ctrl+I 

Expand All Ctrl+] 

Expand/Collapse Toggle Ctrl+\ 

Find & Replace Ctrl+F 

Find Next F3 

Find Previous Shift+F3 

Insert Date/Time Ctrl+D 

Insert/Edit Thought or Web Link Ctrl+K 

Italic Ctrl+I 

Open in Browser Alt+Ctrl+O 

Pop up Table of Contents Ctrl+T 

Print Ctrl+P 

Replace Next Ctrl+F3 

Replace Previous Shift+Ctrl+F3 

Take Action Ctrl+L 

Underline Ctrl+U 

 

Options Commands Shortcut 

Web Search F4 

 

Thought Commands Shortcut 

Create Child F6 
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Thought Commands Shortcut 

Create Jump F8 

Create Parent F7 

Forget Ctrl+Del 

Open Folder Shift+Ctrl+F 

Show Thought Properties Ctrl+Enter 

 

Thought Icon Commands Shortcut 

Select Stock Icon Alt+Ctrl+I 

 

View Commands Shortcut 

Collapse All Ctrl+9 

Expand All Ctrl+0 

Mind Map Shift+Ctrl+3 

Normal Shift+Ctrl+1 

Outline Shift+Ctrl+2 

Zoom In Ctrl+= 

Zoom Out Ctrl+- 

 

Window Commands Shortcut 

Close Tab Ctrl+W 

Close Window Alt+F4 

Keyboard Focus to Notes Ctrl+N 

Keyboard Focus to Search Ctrl+S 

New Tab Ctrl+T 

New Window Shift+Ctrl+N 

Next Brain Tab Ctrl+Tab 

Previous Brain Tab Shift+Ctrl+Tab 

Rotate Splitter Shift+Ctrl+D 

Splitter Left or Up Shift+Ctrl+A 

Splitter Right or Down Shift+Ctrl+S 
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Default Shortcuts for macOS 

Create Child Alt+Command+Down 

Create Parent Alt+Command+Up 

Create Jump Alt+Command+Left 

Rename Alt+Enter 

Focus on Plex Cmd+S 

Focus on notes Cmd+N 

Search Web Cmd+E 

Experimental Preferences 

 
Figure 81. Experimental Preferences 

The features and settings on the Experimental tab will change from time to time 
and may be removed in future versions of TheBrain. 




























































































































































































































































































































































